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SUBMISSION GUIDELINES FOR PIQUE MAGAZINE 

PIQUE Magazine is currently accepting submissions for the 
upcoming Fall 2007 and Winter 2008 issues. This is a unique 
opportunity for students in the AIPH community to have their 
work professionally published. Photographs are accepted from 
all student majors, however they must adhere to the following 
guidelines for both images and text.

IMAGES
TIFF files only
300 DPI
CMYK only
Flattened--no layers!

WORDS
All images should be accompanied by text such as  a caption, 
artist statement or photo story. Artist statements should be a 
minimum of 100 words and photo stories should be approxi-
mately 250-500 words. Please submit all text as a separate 
Microsoft Word document, not as a layer in the image file.

All file extensions should include your full name and materials 
can be burned to either a DVD or CD. Submission dates are 
subject to change. All images and copy may be edited for 
content or to fit space. If you have any questions please 
contact PIQUE via email at sad185@stu.aii.edu.  

From the Editor’s Desk:

First, let me apologize for the time span between issues.  This Spring/Summer issue was 
originally due at the end of  the spring quarter but, as with any publication in its infancy, the 
priorities, staff  and deadlines shift as refinements occur.  That being said, I hope you enjoy 
this fifth issuance of  Pique and continue to contribute to (as well as look forward to) each 
one. 

As this issue was going to press, the highly successful Philadelphia Stories show in the Art 
Institute Gallery was in progress.  I was part of  the small group of  students invited to assist 
in the matting, framing and hanging of  the show.  This was an incredible opportunity and 
I would be remiss if  I did not convey kudos to curator Maria Di Elsi-Connolly and our de-
partment head Rob Crites for their extraordinary efforts in bringing this to the Philadelphia 
community.  I have personally been thanked by dozens of  attendees who were thrilled that I 
told them about the show.

This fall, the Pique staff  begins to enhance the content of  our “photojournalism magazine” 
in a couple of  ways.  First, we will be supplementing the usual array of  stories and events to 
include the purely artistic and creative aspects of  photography.  This will offer opportuni-
ties to students who wish to submit portfolio, workshop or other personal work beyond the 
news, event or editorial genres.

Secondly, since we have exhausted our instructors with our section on Tips and Processes, 
we will publish new pieces under the categorization Thoughts on...  These will be thought-
provoking original essays and articles that will contain interesting techniques or trends, 
philosophical viewpoints, or other pondering commentaries that the instructor/submitter 
has Thoughts on… We are excited about these new directions and look forward to hearing 
your comments.   Enjoy!  

Scott A. Drake
August 22, 2007

P.S. As we go to press, we are scheduling a bus trip from 1622 Chestnut to the PDN 
PHOTO+PLUS Expo at the Jacob-Javits Center in New York City on Friday, October 19.  
Pre-register at www.photoplusexpo.com prior to September 27 for FREE ADMISSION to 
the expo.    
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Exploring Arizona

I have always lived my life for nature and the 
great outdoors. Now for the first time, I had 
my plane ticket for a trip out west. My fiancé, 
Amanda, had family living in Sedona, and they 
wanted us to visit; how could I say no? I had 
been buying and packing everything I needed 
for my trip a little too early, a few months to be 
exact. It was Arizona or bust and that was my 
thought, every second of  every day until it was 
time to leave.  I had an image of  what it would 
be like in my mind; however, I was soon to be 
humbled. 

Upon arrival I was astounded at how different 
everything was, but how could I not be when 
I’ve never really left the east coast.  We took a 
shuttle from the airport; I will never forget that 
ride through the giant Saguaro cacti, and onto 
the red rocks of  Sedona.  It was warm, and the 
sun was blasting the rocks, which were emitting 
a saturated glow.  I remained awestruck for the 
whole trip from that point on.  

A few days later, after a little exploring, we 
were on our way to the place I had only 
dreamed about seeing one day, the Grand 
Canyon.  The ride was dreary and rainy.  I kept 
a keen eye for crossing elk; they are everywhere 
up there.  

I would like to say that Grand is far too 
small of  a word for what the canyon really is.  
However, it was pouring rain and a complete 
whiteout when we arrived.  Amanda’s aunt 
bought us a room for the night at the Bright 
Angel Lodge on the south rim.  This was a 
nice place to escape the drenching rain.  The 
pictures I took of  the canyon were taken with a 
window of  opportunity of  only about an hour, 
in between the rain that was turning to snow.  
The next morning, the canyon was a cloudy, 
foggy mess, visibility was no further than the 
guardrails.  As we left unfulfilled, our thoughts 
were only of  adventure.  It was still snowing, 
but the further we drove from the canyon, the 
sunnier it got.  We then, on a whim, decided to 
drive to Utah and see the monuments.  
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The sun was beaming, and it was warm again.  
Only open road with canyons on one side and 
mountains on the other stood between us and 
Utah—unless our car decided to die in the 
middle of  nowhere, which of  course it did.  We 
waited all day for a tow back to Sedona.  So 
much for Utah. 

We had 5 days left, so we just explored all 
around Sedona again.  This time we found spots 
that we thankfully did not miss.  The first place 
we went was called the Seven Sacred Pools.  The 
hike was magnificent. We detoured

The view was even more astounding. Vast had 
new meaning for me.     

The time had come to leave, and it saddened 
me. I was told that Sedona and a city in France 
are the only places in the world with a special 
magnetic soil.  People say it changes the way 
you feel; this could not be more right.  The trip 
had without a doubt, changed my life forever. I 
collected my thoughts and about 20 pounds of  
rocks and things from Arizona and headed back 
east.  I shall return one day soon; the west makes 
me feel at home.

along a dried up riverbed.  The pools were 
cascading down a cliff  side, seven naturally 
carved out holes, filled with water.  I can 
only imagine what it looked like during a 
rainstorm.  

On our second to last day there, we went to 
Bell Rock.  It was about a 45-minute hike 
just to get there, and then the hike up the 
rock was spectacular.  It was a wide-angle 
view of  Sedona and the surrounding areas.  
Closer to the top I had to free climb to get 
higher.

Anthony Jacobsen



Hausey

The snowboard and skateboard industry are 
all about motion and movement both in the 
actual sport and the life-style itself.  These 
photographs incorporate all aspects of  the 
industry into vivid, identifiable images.  The 
energy of  the sport comes through the camera 
movement.  The colors accommodate the 
pop-culture growth of  the snowboarding and 
skateboarding industry.  I specifically empha-
sized the logos of  the items of  clothing with a 
flash to achieve a commercial graphic.

Ever since I was in middle school (age 13), 
I have always had a voice telling me, “Skate-
boarding is so cool.”  At that age, I was more 
concerned with a boy that was into skateboard-
ing, but I realize now that I really do love the 
sport.  I also grew into snowboarding over 
the past 4 years.  I love the whole idea of  the 
relaxed lifestyle and just having fun with your 
friends.  I never had that growing up as a child.  
I also love the clothing, the places, the people, 
and the whole attitude of  the skateboard life-
style, even though I never have achieved it. It 
wasn’t until college that I started to find myself  
and what I really enjoy doing. I’ve learned to 
know what I love.

The following photographs are to be advertise-
ments for a skateboard/snowboard company.  
Mainly to be used for magazine ads, the images 
are influenced by motion, light, color, and the 
mere love of  the skateboard and snowboard 
industry.
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Janelle Paules



Community Options

Community Options L.L.C. is a day program 
run by the state that offers contract work, arts, 
crafts and skill building activities to people 
with special needs. The people that attend 
this day program are known as consumers. 
These people are not clients, and they are not 
patients. They do not receive medical treatment 
at this facility. I believe that they are known as 
consumers because we are all consumers. To 
say that they are consumers is to say that they 
are just like everyone else. They are people, and 
they play a role in society. This program offers 
them that sense of  belonging and integrity that 
is found through responsibility. 
 
Lorra Roach manages the Community Options 
site that I focused on. She always wanted to 
have more children, and in a way she got that 
when she started working at this company. 
The consumers are her employees, but they are 
employees with special needs. The consumers’ 
mental conditions range from mild to severe 
mental retardation to cerebral palsy, autism, 
Down syndrome, and head injury related 
conditions. 

This is a photographic documentation and 
personal account of  seven consumers at the 
Community Options site. They are Abel, Dan-
iel, George, Louie, Stephanie, Tony and Vinnie. 
I focused on their behavioral characteristics 
that distinguish each of  them and their mental 
conditions. The moments in these photographs 
were offered to me through the bonds I made 
with the consumers, who have touched my 
heart.
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Kristin Wolak



1111Pigeon

Patricia Colli

There have only been a few times in my life 
where I saw something that made me want 
to stop. I’ve always been an A to B kind of  
person, never a fan of  interruption. But one 
Sunday morning a few months ago, I found an 
interruption that I could not pull myself  away 
from. 

It happened when I was walking past a small 
alley, noticing a large flock of  pigeons socializ-
ing inside. When I came closer to the group, all 
of  the birds immediately took flight. All except 
for one, the one that couldn’t fly. There was 
something different about this pigeon.  I had 
my camera. The reason that I photographed 
this bird was not that it was the only pigeon 
that couldn’t get away from me fast enough. 
The reason that I fell in love with this bird was 
that, in looking closer, I noticed that it had 
some kind of  deformity. 

I was immediately drawn to this bird. A few 
feathers were missing from the back and the 
small patch of  skin peeking through looked 
unhealthy, perhaps diseased. The feet and face 
were the only parts of  its body that didn’t seem 
swollen or abnormally bloated. Did it have 
cancer? Was it a tumor? Was it in pain? After 
a few pictures, I backed off  for a while just to 
observe. The rest of  the birds slowly returned 
to the ground. 

As I saw my bird next to the others, its 
distorted shape became more noticeable. My 
pigeon also could not walk like the other birds, 
most likely crippled due to its sickness. And 
then I saw something that broke my heart. I 
began to see that my bird was being secluded 
and ignored. The rest of  the flock would not 
even acknowledge its presence. When I had 
startled the flock, my bird was left alone on the 
sidewalk while the other birds flew to safety. 
Not one bird stayed to keep it company, to 
protect it, to help it. 

No big deal, it’s just a pigeon. But it’s not just a 
pigeon. While contemplating this cruel behav-
ior, I realized that this situation happens every 
day—with humans. Isn’t it true that when you 
see someone who is mentally challenged or has 
some sort of  deformity, it is hard to look at 
him or her? 

It is not that you don’t care, but that you feel almost embarrassed, not wanting to stare. 
However, this in turn causes you to ignore that this person is even a human being, that they 
even exist. 

In that moment, I wish that I could have become a bird. Because if  I was a bird, I would 
have befriended my broken pigeon. I would not have flown off. I would have acknowledged 
my bird. Because nothing would be more awful than to be alive but not exist.



Self-Examination

(as well as some others to a lesser extent) as 
a starting point for my own self-examina-
tion.  

Using a standard 35mm SLR traditional film 
camera, I have presented myself  within mir-
rors, multiple exposures, slow-shutter expo-
sures, diptych, triptych or a combination of  
these to externalize my internalizations.

One final thought: while I am the subject 
of  each image, I am also the photogra-
pher.  I am never able to see myself  in the 
viewfinder before the picture is taken; when 
the timer is set and the shutter button is 
pressed, I am not in the picture, so when 
the shutter triggers, the person I capture is 
not the me that is taking the picture.  Each 
picture is of  a subject that has stepped out 
of  his usual role and into another persona, 
and it is up to the viewer to determine 
whom they see. 

Socrates said that the unexamined life is not 
worth living.  It is certain that while there were 
many ways a person may have performed self-
examination through various spiritual, philo-
sophical and moral methods in Socrates’ time, 
it is also certain that photography through the 
past one hundred and fifty years has been a 
frequent medium for many modern-day self-
examinations through self-portraiture.

Even in earlier art forms, the self-portrait has 
historically been a vehicle for artists to portray 
how they perceived themselves.  True, some 
painted themselves with more flattering fea-
tures or as better looking than others portrayed 
them, but some rendered their own images 
with personal reflection giving the viewer more 
emotional or spiritual insight.  Many photog-
raphers have taken similar liberties with their 
own self-portraits for innumerable reasons.  
Robert Mapplethorpe used his work to express 
his sexuality, for instance.

My initial motivation was simple enough: to 
force myself  to be in front of  the camera 
and perhaps release personal poor self-image 
feelings that had been established over the 
years.  I have taken some aspects of  the works 
of  Duane Michals, Lee Friedlander and Ralph 
Eugene Meatyard 
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Scott A. Drake



Justin Audet

Scouting the Remains

Located in the eastern coal region of  Penn-
sylvania, Centralia was established as a town 
in 1856. As anthracite coal was and still is 
abundant in this location, it was a home to a 
thriving coal mining industry and a community 
of  working class families. It was a bustling 
borough with its saloons, a couple theatres, 
churches, hotels and, of  course, a post office.  
Two railroads served the area, once coming 
from Philadelphia and Reading, as well as the 
Lehigh Valley Railroad. There was even an 
Irish gang in town called the Molly Maguires, 
and they ran about doing their high jinks, 
engaging in a little debauchery every now and 
then. The town eventually carried a population 
of  two thousand residents and Centralia was 
building itself  a foundation.

Then, in 1962, a vein of  coal that ran far down 
into the earth was ignited when a worker was 
burning a garbage fire at the local landfill. This 
created a mass fire that spread through the coal 
underneath the ground, and all attempts to 
extinguish the fire failed. As anthracite takes a 
while to burn, and it is plentiful in Centralia, it 
has continued to blaze to this day, and sup-
posedly there is enough of  it to continue for 
at least the next couple hundred years. The 
Commonwealth of  Pennsylvania didn’t have 
too much trouble getting the majority of  the 
residents to relocate, aside from the dozen or 
so folks who remain in a place unlike any other, 
but to them, this is home.
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Jeanise Correa

The Theme for this year’s Philadelphia Flower 
Show was “Legends of  Ireland.”  We  
journeyed to the lengendary Tir- na- nag, 
where the leaves are always green and the 
flowers always bloom.  More than two hundred 
select judges came from across the nation to 
take part in the flower competition.

The show had many attractions, including free 
hourly lectures, demonstrations, gardening,  
arranging, garden tea, Celtic music and a mar-
ket place.  The wide range of  markets con-
sisted of  merchants selling tools, sculptures, 
plants, Irish crafts, glassware and artwork.

Flower Show exhibitors undertake the art of  
forcing trees, plants and shrubs into bloom 
for the show, using temperature and lighting 
controls to help the plants fully bloom.



Work for Hire

I use each and every opportunity I am given as 
a student to shoot what I want to shoot. I am 
a fashion photographer to the bone. Although 
it may seem that I have tunnel vision, I believe 
that focusing on your strengths allows you 
stand out above the thousands of  other pho-
tographers in your field. 

These images are four months worth of  pre-
conceived ideas and sketches that I have stored 
in my little book of  crazy concepts over the 
past year-and-a-half  of  my education at the Art 
Institute of  Philadelphia. There is no running 
theme or thread of  similarity within the book, 
which was done purposefully. I wanted to at-
tempt a little bit of  everything. Using women 
from different ethnicities, I captured a varying 
range of  emotions and displayed both their 
intentional and unintentional sexuality. 

The title, “Work for Hire” is based on the 
impending struggle I will find myself  in after 
graduation to find a stable job. For me, these 
images act as a calling card to perspective em-
ployers in the future. 

As for right now, these images serve as impor-
tant mile-stones in my academic career. After 
each photo shoot, I became more knowledge-
able about lighting techniques, make-up, and 
wardrobe or the lack thereof.  For excessive 
demands and early shooting schedule, I’d like 
to thank and apologize to all my friends that 
modeled for me!
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Niesha Huff



Jesse Meyer

Disco Biscuits

The Disco Biscuits are a band that started 
back in 1995 at the University of  Pennsylva-
nia.  Every member of  the band studied music 
there and graduated with music degrees except 
the drummer, who could play almost every 
instrument anyway.  They sought to create a 
new genre of  music, appropriating styles from 
classical, jazz, Jam-band, and electronic dance.  
This genre is known today as bisco.  

The way postmodern artist Duane Michal’s sto-
rytelling series “Things are Queer” cycles back 
to its original image at the end is the way that 
this genre of  music works.   Each written song 
has a beginning, a middle section, and an end-
ing, but rarely do you hear a song played from 
its beginning to end.  Instead you will hear one 
section of  a song improvised into a section of  
a different song and then improvised back to 
end the original song.  Also, the Disco Biscuits 
write rock operas where a series of  songs tells 
a story.  These songs are also improvised into 
one another without a pause or break in music.  
The critical practice in this is carefully plan-
ning out how each set of  music is going to be 
played.  Each individual song has the possibility 
of  being played in three different ways.  First, 
the song could be played as a stand-alone.  This 
means the song is played from start to finish.  
If  the song is inverted, this means that the 
ending of  the song is played first, followed by 
the beginning.  Last, and most complicated, is a 
dyslexic version of  a song.  This means that in 
the first set of  music, you might hear the mid-
dle section or end of  a song, and the beginning 
of  that song may not come until the second set 
or even later on that tour. This raises the music 
to an intellectual level, and not just an aesthetic 
experience. The critique of  representation 
is questioning how we listen to music.  The 
unstudied spontaneity of  this style of  music 
was new and stood in opposition to anything 
that had come before.  The new genre of  Bisco 
defied the normal melodic structure as in the 
repetition you hear in pop songs.  Instead you 
have each member of  the band playing their 
own line of  music harmonizing with the other 
members of  the band to create multiple voices 
instead of  one grand narrative, the expression 
of  the individual at a particular moment.  

     

Appropriating ideas from what we feel is paradise on earth; many of  their songs are writ-
ten about tropical islands and euphoria to create an aesthetic feeling.  The real aesthetic 
feeling, though, comes from the way they play.  Using their jams to slowly bring you to a 
climax unlike anything heard before in the history of  music.              
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Ghost Town

Thomas Puleo

Atlantic City is sought out by more for-
tune hunters than beach goers.  The city is 
synonymous with gambling, but beyond the 
apparent abundance of  wealth is a city of  
extreme diversity and economic contrast.  
Its artificial atmosphere seems to suppress 
its reality; a wasteland littered with dilapi-
dated homes and weathered structures lies 
beyond the slot machines.  Many buildings 
are questionably uninhabited and were it not 
for the life of  the casinos, parts of  Atlantic 
City could easily be mistaken for a ghost 
town.  



Traces

My series, “Traces,” focuses on abandoned 
buildings and objects once loved, but now left 
behind. The buildings, for the most part, can 
be found in and around my hometown. These 
are places I have passed on a daily basis grow-
ing up and have watched as they slowly have 
fallen into a state of  despair. Never knowing 
the people who once inhabited them has al-
ways made me question and imagine who they 
were. The mystery behind these things is part 
of  what drives my ambition to take these pho-
tographs. What happened to the people who 
once lived here? Most people’s lives can be told 
or memories relived through their homes and 
the objects within. Being in someone’s home 
and getting a sense of  the objects inside, what 
they once could have been like, almost con-
nects you to the people who once lived there. 
My intention is to not only allow my own, but 
also the viewer’s imagination to let go.
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Nicole Coy



The Regulars

I used to work as a waitress at a bar.  I would 
work lunch and dinner hours, and sometimes 
cocktail hour.  A lot of  people know what 
the inside of  a bar looks like at the peak night 
hours, but only a few people see the regular 
customers that come in everyday all day.  When 
you work a regular schedule at a bar, you can’t 
help but get to know the people that come in 
all the time.  It starts with just remembering 
their name and their regular drink order, and 
then over time they’ll tell you their story.

There was one in particular that I got to know 
very well from seeing him each day.  His name 
was Bob, and he was divorced with no kids.  
He would come in everyday and stay almost 
all day when he was supposed to be at work.  
Bob was my favorite because after getting to 
know him, I realized he wasn’t just a quiet 
guy sitting at the end of  the bar.  He hid from 
the world on that barstool.  I remember him 
saying to me: “Well kiddo, I wish I could say 
things will get better, but that just hasn’t been 
my experience.”  He had so much sadness and 
pain inside of  him, but everyday he would be 
overlooked as another faceless bar fly.

I met quite a few similar men at that bar with 
many stories to tell, but with no one to listen.  
They all sat together as if  they were holding 
each other up by existing.  Sometimes not a 
word was spoken between them, but they all 
seemed to say the same thing without talking; 
their faces and hunched over bodies told their 
stories of  defeat.  Each day they kept com-
ing back and drinking the same drinks in the 
same routine, trying so hard to forget it all.  
In this series, I wanted to show the profound 
difference in the appearance of  the bar lit by 
daylight.  I also have attempted to portray the 
nameless faces that come in everyday whose 
stories are always overlooked.  And hopefully, 
by these photographs, I will do justice to Bob 
and his quiet sadness, always thinking that the 
world will look better through the bottom of  
a glass.
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Theresa Andreoli



re: construction

The Art Institute of  Philadelphia’s Gallery at 
1622 Chestnut Street has all types of  art hung 
on its walls.  Sometimes the art comes from 
the students; most of  the time it is from local 
artists.  However, never has the gallery been 
curated by the students until this past Decem-
ber 2006 when Patrick Coue’s 20th Century 
Art History class organized four local artists’ 
work to show in the gallery.  With the excep-
tion of  finding the artists, which Patrick helped 
out with, the students did all the work from 
promotion to creating the displays.  

The artists all used different mediums and had 
very different creations, but what tied them to-
gether was that they all used existing objects to 
convey their messages.  The gallery show was 
dubbed “re: construction” to show the four 
different art forms and the four different ways 
of  engaging the world.  Photographer Ben-
jamin Pierce uses existing man made objects, 
such as the first computer ENIAC, to abstract 
with macro photography and create elegant de-
signs.  Sculptor Scot Kaylor uses a lot of  scrap 
from junk yards and other places to create new 
works of  art from discarded stuff.  Installa-
tion artist Amy S. Kauffman uses origami type 
pieces made from wrappers and other paper to 
fill the space she has been given with different 
designs.  Every space she works in is different, 
and so is the art she adds to it.  Finally, video 
artist Andrew Jeffery Wright uses stop motion 
photography to make videos out of  drawings 
he has made for magazines and other media to 
convey his message.

The gallery show’s opening night was Thursday 
December 7th, 2006 and ran through January 
21st, 2007.  The show was the first of  its kind 
and it went off  without a hitch.  The gallery 
attracted so much attention that there will 
undoubtedly be another show just like it and 
hopefully in the future a student curated show 
of  student work.  

Information and more photographs of  the show and artists can be seen at http://stu.aii.edu/~ac1824.

Tyler Gates
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Michelle Killian

Extreme Lengths

The media today sets the guidelines and the de-
fining rules in our society when it comes to de-
termining who is beautiful.  Beauty has become 
an overwhelmingly marketable product for 
American consumers due to the stereotypical 
image that American women have been led to 
believe is true and real.  Women are surround-
ed, by every avenue of  the media, with an 
unattainable image of  what they are supposed 
to look like.  Television shows depict plastic 
surgery as a common practice and suggest 
that every woman consider it.  Runway models 
project the notion that the thinner you are, the 
more desirable you become.  When in all actu-
ality, many of  the models suffer from serious 
eating disorders that threaten their health and 
well being.  This brainwashing approach has led 
millions of  women to go to extreme lengths to 
obtain this image of  perfection.  Whether it is 
crash dieting, hiding their true identity under 
piles of  makeup, or even undergoing surgery, 
women will do almost anything to achieve the 
overly emphasized and highly commercialized 
image of  beauty and perfection.  

Sadly what the majority of  American women 
do not realize is that beauty comes in all shapes 
and sizes.  We are all individuals and not meant 
to follow a particular pattern in order to be 
seen as beautiful.  The uniqueness of  one’s 
character is what truly sets one woman apart 
from another.  Beauty is not something that 
can be measured in makeup, pounds, or inches; 
it is a trait that is seen from the inside out.  
Physical beauty is second to that which comes 
from within.  



Beauty Pains

More and more in our society ridiculous 
standards of  beauty are being shoved in our 
faces, especially when it comes to women. 
Today women have to be extremely skinny to 
be thought of  as “beautiful” and “perfect” in 
the eyes of  this weight-obsessed generation.  
My goal was to show the outrageous things 
that some women do to obtain the look of  
this unrealistic standard of  beauty that is set 
for them. I wanted to touch base on both the 
serious side, such as eating disorders and, on 
the lighter side, how women spend hours doing 
hair and makeup and hurting themselves just 
to look perfect. Overall I wanted to show the 
torture of  what women do to get the look of  
perfection presented to us by our society.

In today’s age, the one that uses computer 
technology to enhance things, how do we 
know what is real and what is retouched? Well, 
the answer is, we don’t, but still women find 
themselves striving to look like these retouched 
images they see every time they flip through 
the pages of  magazines. Women may do some 
silly things to enhance their looks, such as us-
ing scary things that almost look like medical 
tools to pluck their eyebrows and curl their 
lashes. But they also do some very scary things 
that could permanently harm them, such as 
binge and purge and just obsess over weight in 
general. 

I wish I could say that as a woman I did not 
care about what society thinks.  I will admit 
that I too use those scary tools to pluck my 
eyebrows and have my days where I obsess 
over my weight and think things like “why 
can’t I look like her?”  However, the reason I 
did this project is because I do genuinely care 
about this issue, and I would love for women 
to just love themselves for who they are, and I 
include myself  in wishing to do the same. 
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Meg Urbani
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Thoughts on Photoshop Workflow:
It’s difficult not to be enamored of  the digital image when it opens on the monitor: it’s right 
there and you didn’t have to do anything to get it there, really. It’s like reality—except that it’s 
a photograph, which is not in any way reality. Which is why we have to work on the picture: to 
make it better mimic reality.

When the image opens in Photoshop sit back and look at it for a moment. Go to a black 
screen and press Tab to remove the palettes and press Command plus “R” to get rid of  the 
rulers if  they’re open. Examine the picture. Look around the edges to see where there might 
be lighter areas that draw the eye. Look for color bias in the neutrals, the highlights and the 
shadows. Consider what needs emphasis and what needs to be suppressed. Get over the 
visceral “liking” of  the picture. It’s OK to like it, but understand it, too.

That’s not to work it to death. The workflow doesn’t necessarily need dozens of  layers. 
Sometimes, yeah, it does, but it’s more important to be smart about what the picture needs. I 
see a lot of  people try to fix local areas with stacks of  global layers. They make a light corner 
darker but then the center is too dark so they make another global layer to lighten the center 
when instead they should have painted on the layer mask to limit the effect or made a selection 
and worked only on the area that actually needed the adjustment. It’s counter productive and 
time consuming to make a lot of  conflicting global layers. Three global layers are about all 
any photo needs before going to selections and burn/dodge layers: one to set black and white 
points, one to (maybe) tweak contrast and one to adjust overall color bias. Some of  the color 
adjustments can be made in Levels or Curves so it’s conceivable that only one global layer 
might be necessary: a single curve that does all three. (I’m not considering sharpening here, 
which requires a global layer or two all its own.)

Use selections and layer masks to refine an image. If  making a selection is too cumbersome, let 
the layer effect the whole image then invert the layer mask and paint with white to reveal the 
effect in the areas where it’s needed. Like the photo, but refine it intelligently.

Jay Pastelak

From the Pique staff:
Make your submission process easier!  Create an Action Set in Photoshop.

1. Open an image to record the action operations.
2. Reduce the size of  the image so that the longest side (height or width) is no larger than 10 
inches. 
3. Click on the Actions pallet or open the Actions pallet through Window>Actions.
4. Click on the Create New Action button on the bottom and give it a name.  (We suggest 
calling it Pique).
5. Click to Image>Mode>CMYK.
6. Click to Image>Image Size.  Change the resolution to 300 dpi. Make sure that the “Resa-
mple Image” checkbox is selected.
7. Click to Edit>Convert to Profile. From the drop-down box, select “Adobe RGB(1998)”. 
Click OK.
8. Click to File>Save As... Change the format to TIFF.  Click Save.
9. On the Actions pallet, click the Stop playing/recording button on the bottom left.
10. Verify your image has been saved correctly.
11. Open a new image and size it.  On the Actions pallet, click on Pique, then click the Play 
button on the bottom.  This should perform all of  the actions you recorded and make any 
magazine submission process easier.

THE JULIAN LEVY GALLERY AT THE PHILADELPHIA  
MUSEUM OF ART 
Dreaming in Black & White: ARTHUR STIEGLITZ 
Through November 4, 2007

A preeminent figure in twentieth-century photography, Alfred Stieglitz changed the 
face of the medium with his well-crafted prints, his passionate efforts to establish 
photography as a fine art, and his daring art gallery known as 291. After his death in 
1946, his wife Georgia O’Keeffe carefully selected a handful of institutions to receive 
representative gifts of his work. Her 1949 donation to the Philadelphia Museum of 
Art formed the foundation for the Museum’s renowned and ever-growing collection 
of photographs, now numbering around 29,000 images. 

The inaugural exhibition in the Levy Gallery, in its new location in the Ruth and 
Raymond G. Perelman Building, pays tribute to this integral and treasured holding 
by featuring a selection of approximately 40 masterpieces from the Museum’s 
extraordinary collection of 600 photographs by the artist. In addition to the group 
of Stieglitz images donated in 1949, the exhibition features art from the collection 
of photographer Dorothy Norman, a student and close associate of Stieglitz’s, who 
donated her personal collection to the Museum and founded its Alfred Stieglitz Cen-
ter in his honor. Also included are recent gifts from the Georgia O’Keeffe Foundation 
that have not previously been exhibited. Demonstrating the range of Stieglitz’s work 
as well as of the collection, the exhibition includes large photogravures, portraits 
of artists, selections from the series Georgia O’Keeffe: A Portrait and Equivalents, 
a group of portraits of Dorothy Norman, later images of poplar trees at Stieglitz’s 
family retreat at Lake George, New York, and views of New York City photographed 
from his home in the Shelton Hotel. 

ARTHUR ROSS GALLERY AT THE UNIVERSITY OF  
PENNSYLVANIA 
Through October 15, 2007

 “Beauties and Other New Work, Photographs by Evelyn Lauder,” thru July 16 | All 
proceeds from this traveling exhibition are donated toThe Breast Cancer Research 
Foundation, which supports the Abramson Cancer Center at Penn | “Modern Latin 
American Culture: Annemarie Heinrich, Grande Dame of Argenine Photography,” 
Aug 26-Oct 15 in cooperation with Dean Eduardo Glandt & the Guillermo  
Rosenblum Foundation, Buenos Aires 

 

GALLERY 339
TINA BARNEY: WORLD STAGE 
September 15 - October 27, 2007

World Stage is an exhibition of recent and early portraits from the  
internationally renowned photographer Tina Barney.  World Stage weaves together 
Barney’s portrait work from over the past twenty-five years, including images of her 
family and friends, portraits of European aristocracy, and her most recent photo-
graphs from China.

 

PHILADELPHIA MASTERS
November 2 through January 5, 2008 

George Krause, William Larson, Ray K. Metzker, Ruth Thorne-Thomsen

MICHENER MUSEUM      

Gershwin to Gillespie: Portraits in American Music
Through October 7, 2007

A salute to 20th century music is being presented via this photographic exhibition, 
organized by George Eastman House International Museum of Photography.

THE GALLERIES AT MOORE; MOORE COLLEGE OF ART 

Joel Katz; “Mississippi 1964: Images From Freedom Summer”
Through October 14, 2007

Exhibition showcases Joel Katz’s civil rights photo essay “And I said No Lord”  
presented in honor of Constitution Day, Sept. 18.  Katz, an artist living in Philadel-
phia, has been an adjunct faculty member at Moore and continues to serve as a 
visiting artist.



The Vineyard

In 1978, Mr. Nissley transformed an old  
tobacco barn into the  winery as the first step 
towards his dream of  making wine. The   
winery suffered a tragic fire in which a large 
portion of  the facade was damaged in  
January of  2006. The Nissley’s rebuilt the win-
ery  exactly like the former structure to keep 
the original appearance  that Mr. Nissley loved.

After the death of  the Nissley’s, the winery and 
estate was left to  their four children who own 
and operate it to this day. The oldest  sibling, 
who runs most of  the winery’s operations, still 
resides on the  estate.
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Tara Bonner



Life at a Halfway House

Liberty Management Services, located on 
Lehigh and Germantown Avenue in North 
Philadelphia, opened in 1996. It is a halfway 
house designed to help those just released 
from prison to readjust to their community 
and give them time to live a crime free life. 
LMS is a house that can hold up to 125 
men who have been put on pre-release from 
prison or are on parole. The living quarters 
take up two floors with rooms set up dor-
mitory style and holding anywhere between 
3-7 residents per room and three bathrooms 
on each floor.

While at LMS, residents have freedoms not 
found in prison, though they are still under 
a watchful eye by the staff. Residents are al-
lowed to leave for a period of  time each day, 
called social time, and are required to be in 
before 10 pm. Head counts are taken nine 
times a day to assure that everyone is where 
they are supposed to be, and each floor is 
watched by a staff  member to assure that 
everything is safe and secure. The residents 
are required to find employment and hous-
ing before they are allowed to leave LMS 
and go back out into society. I followed the 
stories of  three residents who have been 
at LMS for various amounts of  time, and I 
photographed their daily lives.

Charles, 62, a resident of  LMS for one year, 
was a mortgage broker and was incarcer-
ated in March 2004 for misappropriation of  
funds. Right now he is working on opening 
a lottery/check cashing store in West Phila-
delphia and is searching for a place to live.
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Alfonso, 51, was arrested in 2002 for the 
sale of  cocaine and marijuana. He has been 
at LMS since July 2005 and has been work-
ing at a catering company for over a year. 
He is waiting for his housing to be approved 
by the parole board before he can leave.

Duane, 34, was arrested in November 2001 
for the trafficking of  cocaine after selling it 
for the past 10 years. He has two sons who 
have been living with their mother while he 
has been at LMS for the past five months. 
He was released from LMS on  
November 8, 2006.

Abigail Elliott



Segmented-Scapes

Part of  my personal goal as an artist is to 
organize my own visual world.  Luckily for me 
the composition heavy medium of  photogra-
phy allows me to have ample means to achieve 
this goal.  While studying at The Art Institute 
Of  Philadelphia, I began to see how these 
visions of  organization could become physical 
products of  art.  As time passed in my studies 
there, I began to work more and more with 
the largest format equipment I could acquire.  
This was all in an effort to maximize the detail 
within the frame of  the image.  Capturing 
this level of  detail helped me to organize the 
microcosms of  activity located in my work 
at the time.  While this large format body of  
work began to flourish, I began to feel a level 
of  constraint.  I began to notice that reality, as 
it evolves, sweeps me with it.  I was constantly 
taken in by everything around me visually, and 
while not everything struck me the same, I 
became aware of  a contradiction:  I always saw 
how beautiful a scene could be, if  I were able 
to change it.  

In practically every case there was nothing I 
could really do to change the visual composi-
tion of  the scene.  When using the 8x10 field 
camera, I was always left with a perspectively 
correct, deadpan image. 

The reality I saw around me craved to have a different bridge built between imagination 
and the subsequently captured photography.  I began to take a small 35mm half  frame 
camera with me to all locations I was shooting at the time.  This camera created angles 
that were wider and more distorted.  This camera allowed me to use its format to create 
new ways of  viewing my world around me.  Since the half  frame 35mm format was 
more continuing and consecutive in nature, I was able to visually organize the entire 
idea of  these scenes and not just isolate or extract a piece of  it.
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Jonathon Hanitschak
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